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Getting Started 

DAT-MAIL Program Setup 

Program Setup for EII 

DAT-MAIL Program Setups and Defaults 
Program set ups are accessed from the "File" menu. A grouping of Setup Tabs will appear.   

("Import Defaults" tab information can be found here) 

 

Mailer Information Tab  
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Enter all of your pertinent Mailer information including name, address, IDEAlliance Provider Code 

and DUNS here. 

 

DMU Verification Allow USPS Access to Maintenace Functions - This option will allow the 

USPS terminal to run Internet Updates and other program maintenance functions.   This is only 

recommended if they are using a standalone (local) copy of the DAT-MAIL program.  

 

 If they are connected to your live network program, leave this unchecked. 

 

Do Not Allow USPS to Import Mail.dat Files - This option removes the import icon and File 

Menu options when the program is in DMU Mode. Checkmark this option if your DMU clerk is 

using files on your network.  
 

Display Mail Sortation Reports for USPS - This option provides access to the sortation reports 

from the "Reports" menu if the USPS is using DAT-MAIL to do verification and mail acceptance.  
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Planalyzer Tab 

 

 
 
Planalyzer (or Quick Plan) - Use this tab to set up default parameters for running drop ship 

optimization on your files immediately after import via the "run Freight Table after Import" 

checkbox on the "General" tab.  If you have our Toolbox registration, you can check the "Use 

Planalyzer" box and choose a Freight Table to perform cost-based drop ship optimization. 
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PostalOne! Tab 

 
 

   
 
Default PostalOne! Release Path - Use this button to browse and select the path you want to 

place the Mail.dat release files generated by DAT-MAIL for uploading to PostalOne!.   Note: You 

can Suppress the export of an Original Release file to the PostalOne! website Fill in your Mailing 

information here for the PostalOne! release file.    

 

Business Entity ID - When this six-character numerical field is populated, the information is 

then embedded and displayed in the FAST Barcode on your printed Pallet Placards.   The USPS 

will tell you what your specific Business Entity ID is and any fields not used will be padded with 

leading zeros.    

 

Generate Statements or Only Create Release Files - choose one of these radio buttons. If 

you do not plan on generating postage statements from your Mail.dat files and will only be 

participating in PostalOne!, then you should uncheck Generate Statements. Login Info and Permit 
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Info buttons give you a place to access, enter and edit the applicable information necessary for 

participation in PostalOne! Web Services. These setup buttons are for a feature that allows you to 

upload your Mail.dat qualification reports and postage statements to the USPS website for 

verification. 

 

 Review our supplemental guide titled PostalOne!, FAST and Detached Mail Unit Verification 

User's Guide for detailed information regarding the setup, activation and use of PostalOne! 

through DAT-MAIL. 
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Startup Options Tab 

 

 
 

Job Options - The list of Jobs that are imported into the program can be sorted by one of these 

selections. 

 

Entry Point and Display Order - Choose either by ZIP code ro by Production Seq. 

 

Start Up View Options - After a Mail.dat file is imported, you can choose a default View that the 

program will display for you.  The default is the "Navigator" view. 

 

Restrict Job Selection by Revison No. - If you tend to import the same Job multiple times due 

to changes in presort processing, you can choose to activate this option which will allow only the 

latest file revision to be selected for editing. 
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Statement Generation Tab 
 

 
 
Client/Permit- Enter defaults for Automatic Statement Generation.   The default Client will be 

used during automatic statement generation in conjunction with our Daemon or single file import 

process if the option to 'Generate Statements Automatically at Import' has been activated.  

 

Optional Procedure - Check this checkbox if the bulk of your mailings are verified under an 

Optional Procedure agreement.  At the time your statements are to be generated, you can choose 

to uncheck the Optional Procedure box if the mailing is not part of your OP agreement.  

 

Generate 8125 - Recommended if you will be generating postage statements for destination 

drop ship entry points.  An 8125 will be created automatically from your statements. 

 

Drop Ship - This controls whether or not a Consolidated statement will be generated for your 

drop ship mailings.  This setting can be overridden at the time of statement generation from a 
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single file import or through automatic statement generation from a single file import.   This 

setting is ignored by our Daemon which uses a different technique to automatically detect drop 

ship from non-drop ship files.  

 

Update Container Grouping-ID to Zip Ref - The update Container Grouping-ID to Zip-Ref will 

update your Group 1 Batch Code or Postalsoft Entry Point Number to the Zip Reference field of 

the statement. When you print a 3602-RV, the Zip-Reference number can print in each statement 

section.  

 

Generate Statements Automatically on Import - This turns on the feature that allows you to 

generate statements automatically after the Mail.dat import is complete. This feature can be used 

when you do NOT need to make any changes to your Mail.dat file in relation to entry facility. 

 

Set Import Date and In-Home Delivery Date to 0 - If you are generating your statements 

automatically upon import and do not want them to have either mail dates or in-home dates, 

enable this option. When statements are created, the rate table used will be based on your 

computer's system date. When the mailing actually takes place you can change the postage 

statement's date. This way it is easy to tell the difference between statements for mailings still in 

production vs. statements that have actually mailed. If you are registered for DAT-MAIL 

PostalOne! Web Services, you will also see a checkbox. 

 

Run POWS Qualification Report before Statement Generate - Note: This is an obsolete 

setting and will be removed from future versions of the program.  

 

Applied Postage Information - These defaults will be used if you are creating a statement with 

affixed postage but they can be changed if you are not using the Automatic Statement Generation 

feature.  

 

Applied Method: If you select Neither, you can enter the applied rate. This rate should be equal 

or lower than the lowest postage rate being mailed.  Lowest - This automatically applies the 

postage for each entry point at the lowest postage rate used by each entry point. If not all entry 

points are being mailed at the same rates and you are applying the postage at the same rate for 

all entry points, it is best to select Neither and enter that rate. Correct automatically applies the 

correct postage.  

 

Balance Paid By: If you have applied the postage at a "Neither" or "Lowest" Rate, there will be 

postage due for the mailing. You must select a payment method for this balance. If you select 

"Permit" or "Trust", you must also select the permit/trust account that is being used. 

 

Permit: If the balance is paid by permit, select this option and select a permit. According to DMM 

regulations you must also create a 3600-R, 3602-R or 3602-N for this “ additional postage. If you 

do not do this and are using the Postage Accounting program, this postage usage will not be 

allocated to the job. If you do not create these extra statements, then you are really using your 

permit as a trust account and should choose "Trust" instead. 

 

Trust: Selecting "Trust" still requires you to select a permit but you do NOT have to create an 

additional postage statement for the balance due. 

 

Meter: If you are applying a meter strip on the postage statement to pay for the balance due, 

select "Meter". 

 

Stamps: If you are applying stamps on the postage statement to pay for the balance due, select 

"Stamps". 
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Check: If you have an arrangement where you are directly paying the balance due by check, 

select this option. If you are expecting a value added refund however, this will be the selection to 

make since the overpayment is not applied to a permit or trust account.  

 

Automatic Client Job and Mailing Agent Identification Options 

When activated these options are used with automatic statement generation during the Mail.dat 

file import (using the Import Daemon or during a single file import). 

 

 
 

Automatic Client Identification Radio Button Choices: 

   

"Not Activated" (Default) turns the option off.  When any of the other three radio button options 

are selected the feature is considered ON and parses the Client code from the three possible 

sources (File Name, original job id, or hdr:UserOption).  

 

"First Characters of File Name" (must enter end position) - this is the name of the Mail.dat file set 

itself  (i.e. datjob.hdr)  

 

"First Characters of Original Job ID" (Job Number) (must enter end position) - can be used in 

conjunction with Job Parsing "Characters of Header User Option Info" (must enter Start and End 

Pos.) - most presort programs will allow information to be entered into the header for use with 

this option.  

 

Automatic Mailing Agent Information - When ON, during Mail.dat file import the company will 

be derived from the Verification Facilty Zip found in the first Segment record. This zip is compared 

against all zips in your Mailing Agent file and if a match is found then that company is the one 

used during statement generation. 

 

Automatic Job Identification - DAT-MAIL has statement generation options which can create 

separate statements for each Job, Version (lot) and payment type (Permit, Meter and Stamps) 

and tie them to a single consolidated statement for each payment type that can serve as a 

commingled statement.  

 

To setup the parsing, you must define how the MPU Description is parsed under Automatic Job 

Identification.  Enter the info on the Job and the Lot (usually referred to by mailers as package, 

copy or version).  If the mailer is not adding a SubJob to the Job, this can be left empty. When 

we import this information, the SubJob is added to the end of the Job number and the two are 

separated with a dash. For instance:  Job 1234 / SubJob 001 / Version 001 will be represented as 

Job 1234-001-001.  

 

The parsing information to enter looks like this:  

 

Job: Start 1, Length 4  
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SubJob: Start 5, Length 3 

Version: Start 9, Length 3 

 
 

Container Tare Weights Tab 
 
 

 
 
 
Container Tare Weights - Most all of our reports include the Gross Weight of your containers.  

We have provied some default values which you may override here. 
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Advanced Settings Tab 

 
 

 
 
 
Build Floating Batch Manifest View – If you are a manifest mailer, check this option to build 

the floating batch manifest during your file import. The “PDR” file must be populated with piece 

ids by your presort program. You also have an option to sort this information „by Segment‟. 

 

Print Delivery Point Barcodes instead of Piece IDs - (This feature is no longer used and will 

be removed). 

 

Change Single Piece Rate for First Class non-Presort – When activated, the program 

interrogates the Mail.dat file that is being imported and if it finds that all of the mail is Single 

Piece rate, it updates the related MPU and sets the Rate Schedule Type value to "Retail".  

 

Send Non-Qualifying Containers to Verification Facility (Standard Mail only) - During 

import, when active, this option will detect „S‟ rate categories in STD Mail files and change their 

entry point(s) to that of the related segment record‟s verification facility zip.    

 

FULL JOB PARSING SUPPORT!  

Here is what you will have access to:  

Job Parsing allows mailers to use a convention of combining Job # and Lot/String/panel into a Job 

ID. DAT-MAIL will then parse this information when we generate statements so that the job 
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number and lot get populated correctly and automatically. For example, you may have 5 Mail.dat 

files for the same job, one for each "lot" in the job. If the Job no. was 5 characters and the lot 

was 3, you would set the parsing so that the first 5 characters of the Job ID read Job and the next 

3 read Lot. 

 

Populate blank container grouping from Segment Description – In conjunction with Job 

Parsing, if your presort program does not populate the Container Group ID field in your container 

file, you can enable us to do it using a specified start/end position from your Segment Description 

information.  The maximum character length of the Container Group ID is nine. 

 

Auto Generate Sibling – In conjunction with the setup option box on the Import Defaults tab to 

'Create Sibling Records on Import', you can specify additional default options.  Select a default 

container type for your trays/pallets.  Choose which type of import (manual or daemon or both) 

should create sibling records.  Also, choose whether or not these sibling records should be deleted 

when the file is exported and specify which type of export. 
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Export / Archive Tab 

 

 
 

Drop Export Settings: 

If you plan to generate files describing each 'drop' being made in a job, you can enter the starting 

drop number here.  In the Mail Schedul View you can now identify which dates each entry point or 

entry point/segment combination will be mailed.  An export button will create CSV tab-delimited 

or an XML file which will include all information needed by a work ticket and setup a 'drop' for 

each entry point for each mailing date. 

 

Use the "Export DSV" to export a tab-delimited file with columns for:  

Job Number, Package, Drop ID, Mail Date, First in Home Date, Last In Home Date, Piece Weight, 

Mail Class, Processing Category, Non-Standard Flat, Non-Profit Flg, Permit Number, Container 

Type, Payment Method, Facility Type, Entry Point, Facility Name, Rate Code, Rate Description, 

Postage Rate, Postage Amount, Pieces, Container Group ID, Destination Entry, and Zone as 

applicable 

 

Activate Open and Distribute Exports - This feature is used in conjunction with Window Book's 
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Postal Package Partner (PPP) program.  Dat-MAIL subscribers can open their Mail.dat files, go to 

the Mial Scheudle View, tag the entry facitilies for which they wish to create Priority drop ship 

labels and export program can then import the Priority Mail drop ship data in a few mouse clicks, 

allowing users to get these records and print their labels in batch mode.  This PPP feature enables 

the industry-leading postal maling and shipping software systems to work together, creating a 

more streamlined overall system for mailers and shippers who are eager to process Priority Mail 

drop shipments more quickly and efficiently. 

 

Mail.dat Export Settings:  

 

Export physical zips as Locale Codes - This feature will populate the physical zip fields in the 

.CSM file with locale codes upon export for non-PostalOne! exports.  PostalOne! exports are now 

required (as of 8/14/2006) to export locale code and the export process will do so regardless of 

this new option.  The locale code is the facility site code of the destination minus the first digit.  

For example, the facility site code for SCF HARTFORD CT 060 is EV20284 and the locale code is 

V20284. 

 

Auto-calculate CSM gross weight - This option will automatically recalculate the gross weights 

in your files upon import using the container tare weights you have defined. 

 

Export using Historical JobID - You can choose to keep your originally supplied Job ID in your 

Mail.dat file when they are exported instead of using DAT-MAIL's Job ID that is uniquely assigned 

each time a file is imported. 

 

Update Sibling Container Mailing Field (SEG-1117) on Export - This setting should be used 

if you encounter PostalOne! validation errors where the Sibling fields are expected to be 

populated. 

 

Do Not Export UPA - This option will suppress your UPA file (if supplied) from being exported 

when you perform a Regular or PostalOne! file export. 

 

Export mail.dat to compressed file - This option will zip your Mail.dat file when you perform a 

Regular or PostalOne! file export. 

 

Export to version - There are times when a Mail.dat specification is in transition and you may 

prefer to keep exporting the prior version rather than using the newest supported version. 

 

Create OCI - You can choose to have the optional OCI file created and included in your Regular 

or PostalOne! file exports. 

 

Use Alpha/Numeric File Naming Convention - This option will ensure that your PostalOne! 

file names are unique for a much longer period of time.  This is often used by mailers who submit 

thousands of files to PostalOne! in a given year. 

 

Spoilage P1! Export Default - The recommended settings for PostalOne! would be to choose 

either W or S. 

 

Archive Settings: 

Allows you to select and set an Archive Default Directory as well as the parameters for archiving 

by date. A checkbox allows you to force USPS approval before Archiving  

any Mail.dat files. 

 

Archiving is essential for two reasons... 
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1. It keeps your Job List from being overpopulated with mailings that are completed. 

2. If you are mailing under an Optional Procedure agreement, you are required to retain your job 

information for at least a period of one year. 

 

When you choose to archive, DAT-MAIL automatically puts your file into a zipped format to reduce 

the space requirement. 

 

Using a a Command Line to Semi-Automate: 

 

The Mail.dat archiving utility can be run from a command line.  MDARC.EXE can be followed by 

/A=<No. of days> and /D=<folder to put the archive files>.  When it is launched with these 

command lines, there the screen displays an archive time.  You set it to a specific time (ie. 2:00 

am) then start the archive, then minimize.  Every day at the allotted time it will archive all 

Mail.dat files over the number of days specified with /A= and place the archive files in the folder 

specified by /D=. 
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Pallet Tracking / Intelligent Mail Tab 

 
 

 
 
Enable Pallet Tracking - This feature automatically activates "Generate Unique ID's for Pallets" 

when selected.  All uniquely numbered Pallets will be added to our pallet tracking database.  

Note: this is a critical setting if you are using the D.I.M.E. interface for RR Donnelley.  

 

For Mailers participating in Intelligent Mial Container Labeling:  

 

Participate in Intelligent Mail Barcodes - by activating this setting, our program wil either 

assign unique IM Codes or log your unique IM codes. 

 

Overwrite Pallet Label 24 char barcodes - choose this option if you would like the program to 

generate your unique IMCL codes. 

 

Overwrite Tray/Sack Label 24 char barcodes - Choose this option if you would like the 

pogram to generate your unique IMTL codes. 

 

IMB Numbering: 

 

Assign or Log at Import - Choose this option if you would like the program to create or log 
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your unique IMTL/IMCL codes when your files are imported. 

 

Assing or Log at Tag Printing - Choose this option if you would like the program to create or 

log your unique IMTL/IMCL codes when you are printing Tags/Pallet Placards. 

 

  IMTL/IMCL codes will only be created if you have the "overwrite' otpions selected. 

 

Register IM Piece Barcodes - Activate this option if you would like the program to write your 

unique IM Piece barcode to our MS SQL Database.  when the IM Piece barcodes are in the MS SQL 

database, we can query that table when you want to apply spoils/shorts. 

 
 
Maintenance Tab 

 
 

 
 
 
The settings shown here are helpful to Window Book's Support Technicians and should not be changed.  
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Statement Setup for EII 

Statement Setups  
 
DAT-MAIL Statements can be generated in two ways:  

 

1. Statements can be generated from a Mail.dat file.  

2. Statements can be generated via data entry, without the need for a Mail.dat file.      

 

Access Statements via the 3602 Icon  on the toolbar or via the Utilities => Print Statements 

menu. To access your DAT-MAIL Statements Set Up Tabs, open the DAT-MAIL Statements section 

of the program by clicking on the 3602 icon or via the Utilities Menu as described above.  Click on 

File=> Program Set Up.  

 

 

General Info 
 

 
 
If you do not see the OK, Cancel, and Help buttons, try positioning the box as far into the upper 

left hand corner of the program window as possible.  (You can click on the Window=>Tile 

menu to accomplish this).  If you still cannot see these buttons, check your screen resolution 

which must be at least 800 x 600. 

 

Use Quick Date Entry - when this is checked you can type in an abbreviated date - mmddyy 
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would bring in current month/day/year – 051213 would display as May 12, 2013. 

 

Auto Number Client Records - when this is checked, the unique client codes will be assigned 

automatically. If not, the user must assign a unique client code for each client entered. 

 

Lookup Clients by Code - normally DAT-MAIL will allow client look-up by the first few letters of 

the client's name when creating Statements. If you prefer to use the client code instead, check 

this box. 

 

Limit Piece Counts to Master Statement Quantities - if the user is working from a Master 

Statement, he/she will be prevented from entering a mailing quantity for any rate greater than 

the balance in the Master Statement. If this option is not checked the user will be warned but will 

be able to over-mail the rate. 

 

Create Postage for 3606 Receipt - if this box is checked the default setting for the "Create 

Postage Entry" checkbox in the 3606 program will be checked. This includes the 3606 postage in 

all reports in addition to the service charges.   

 

Clear Check Request After Report - After running your Check Request report, the statements 

that have already been included will be dismissed from the next Check Report that you run -

 helpful if you need to run the report more than once a day.  

 

Do Not Verify User 1 - When DAT-MAIL creates statements, it updates the last client, permit, 

job description back to the job file, the permit gets updated as the default permit to the client file. 

This is a great feature for mail owners who don't want their master files altered by creating 

statements. 
 

Protect Job and Client File - by checking this option in program setup, the program will not 

update your Job File with the client and permit information in your "new postage statement". 

   

Example: If you create a postage statement for Job ABC and select Client 123 with Permit 456 we 

are not going to "hard code" this into your Job File for Job ABC - so Job ABC will not be associated 

with one particular client and permit number. Also client 123 will NOT be associated with only 

Permit 456.   

 

Entry or editing of this data: 

 

Enable Non-identical Mailing Verification - Our program has two weight verification systems. 

  One (the default) requires identical piece weight and the other works with Non-Identical 

weights. With the non-identical option turned on, the program adjusts pound postage on pound 

rate mailings based on actual mail weights.   You enter the weight of each pallet in the mailing, 

then our system subtracts the tares and compares the mail weight for the physical pallets with 

the weight in the statement.   If it is different, the pound postage is adjusted in the STD mailing.  

 

Do Not Preview Any Reports - if this is checked, all reports print directly to the printer. If it is 

not checked, the user is prompted to preview the report first, after which the report can be sent 

to the printer. 
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Statement Defaults 
  

  
 
Rates Lookup Statement Date - if the mailing date is left blank, this date is used to pick the 

correct rate table. It should be changed whenever a new rate table takes effect. 

 

Default Mailing Agent - enter the mailer code that will be the default applied on your 

statements.  

 

Mail Under Optional Procedure - If your company participates in the USPS Optional Procedure 

Program, check this checkbox. You will be able to indicate whether each Statement is mailed 

under Optional Procedure and all "OP" Statements will appear on the OPTIONAL PROCEDURE 

REPORTS available in the Daily Reports menu.   Currently, this is an ALL or NOTHING setting box. 

  If you have certain statements that you do NOT want mailed under Optional Procedure you will 

have the option at the time you create your statements to uncheck' the box. 

 

 When 'Mail Under Optional Procedure' is activated, the program automatically sets the 

Sequencing Auto Numbering scheme to Permit No. and Receipt Auto-Numbering to Control No.  

 

Include Meter and Stamps in the Op Report - If you would like your Meter and Stamp mailing 

statements to also be included in the Optional Procedure reporting, check this box.  

 

Lot Required - If you want to force the Lot to be added when statements are entered. 

 

Add Sequence Number to CAPS ID - Will help aid in tracking CAPS accounts. 
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Do Not Populate Default Mailer and Permit - Allowing for blank, last minute hand entry. 

 

Default Move Update Method - Choose from available options.  This value will be used if there 

is not a Default Move Update Method identified in the Client record being used for the postage 

statement. 

 

Limit Piece Counts to Job File - If you enter a number of pieces in a Job record that should be 

mailed and you check this box, you will not be able to create a statement for over that amount. 

 

Do not auto-populate Form Type on Misc. Statements - By checking this box, you will 

prevent the system from assigning the Form Type value from an existing Job record into a 

Miscellaneous Statement. 

 

Default Statement Form - This default allows you to select the statement that you use most 

often as a default.  

 

Default Statement Listing Order - This default lets you choose the default sequence in which 

you will see your Statements. Press the radio button for the desired choice: Control Number, 

Permit Number, Client, Job or Receipt. 

 

Default First Class Weight Type (Pounds or Ounces) - default unit of measure of piece 

weight when creating First Class Statements 

 

Default Std(A) Weight Type (Pounds or Ounces) - default unit of measure of piece weight 

when creating Standard (A) Statements 

 

Default Rate Tree on Statement Add (Normal, Expand All, Contract All)      

 

Normal  - shows all available parts and entry discounts with no rates. You would expand only the 

tree sections that contain the rates at which you are mailing. This way all the rates you are 

mailing may be visible on the screen without any scrolling.  

Expand All - Shows all parts, entry discounts and rates. You would scroll down to each rate you 

are mailing and enter your piece counts. For Standard mail, you would most likely have to scroll 

down the screen to get to all of your rates.  

Contract All - Shows only the available parts for each Statement. You would expand both the 

parts and the entry discounts to get to the rates. This will display the smallest amount of 

information needed to enter the piece counts. 

 

Sequence Auto-Numbering - Choose the method you wish to use to automatically assign the 

Mailing Sequence Number of each Statement. You may elect not to auto-number your Mailing 

Sequence number but DAT-MAIL Statements can auto-number this number three different ways.  

 

1. It can assign the Mailing Statement's Control Number 

2. It can use the "Permit Control" number  

or  

3. It can use the job number.  

 

Each time a mailing is made with a permit, the permit control number is incremented. For 

example, if you are doing three Mailing Statements on permit number 100, the permit sequence 

numbers could be 100-341, 100-342 and 100-343. If you are Mailing under Optional Procedure, 

two separate Permit Sequence numbers are supported, one for mailings made under Optional 

Procedure and one for mailings not done under Optional Procedure.  
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This is why the Permit Control number is the preferred Sequence Numbering method if the mailer 

is mailing under Optional Procedure. The Job Control number takes up to eight characters of the 

job number and adds a dash followed by a number. If you do five Statements for job 1542, the 

Job Control numbers will be 1542-1, 1542-2, 1543-3, 1542-4 and 1542-5. 

 

Receipt Auto-Numbering - You can assign no number the Receipt Number field or assign the 

control number, permit sequence number or a Year/Week code. The Year/Week code prints the 

year followed by your fiscal week number based on the fiscal year begin date that you can enter if 

this numbering method is used. The Job Control number can also be used as described above. 

 

  We highly recommend that either the Receipt Number or Mailing Sequence 

Number be assigned to the Control Number!  This makes it easier to locate your Mailing 

Statements in the program.  
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Print Settings 

 

 

 
Default Statement Copies - The number of Statement Copies you normally print  

 

Print Employee Name - If an employee code is entered, the employee's name is printed in the 

Statement in the signature block.  

 

Print Employee Initials - If checked, the employee initials print on the bottom of the 

Statement.  

 

Print Client Code On Statement - If checked, the code used for each Client will print on the 

statement.  The printed code will appear in the Client Information box at the upper right-hand 

corner of the statement in a small font.  
 

Printing Adjustments - Use these settings to customize your printing of statements as needed.  

 

Enhanced Statement Printing - We are transitioning our printed statements to use a .NET 

technology for enhanced printing methods.  Soon, these boxes will be removed and will become 

the default. 
 

Create PDF version of Statement when Printing - During statement printing, a copy of the 

statement will be printed to a .PDF and stored in user-defined directories. 
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8125 Settings 
 

         

 
Always Create 8125 - Toggle checkmark on and off as desired. This controls whether or not you 

want our system to automatically create a corresponding 8125 when you have manually entered 

a drop ship postage statement.  

 

Fill in 8125 Section 2 - Section 2 is supposed to be filled in by the USPS but many Bulk Mail 

Acceptance personnel prefer the mailer to fill in this section. Check this box if you want the 

statement information pulled into this section.  

 

Contains Mailing Pieces for Outside Delivery Area - Checks the appropriate box in Box 14, 

"Mailer Information".   

 

Default Format - DAT-MAIL supports two different 8125 formats - (1) Regular 8125's and (2) 

consolidated 8125's.  Consolidated 8125's prints out all the mailings in a list format. 

 

Default Origin - Indicate what the usual origin of your mail is - Mailing Plant or Post Office.  

   

Mailing Agent Code   - Enter the default Mailer ID that you want to print on your 8125's.   This 

value will be used unless the statement has a different Mailing Agent assigned to it 

 

Appointment Number - Leave this blank unless you have a standing appointment number with 

your Detached Mail Unit or Post Office.  

   

Default values used when not defined in Mailing Agent Record USPS Employee 

Information - To print as a default in Origin Post Office Section 2   PRINTS BOX 26a (Std A) 

 

USPS Phone - PRINTS BOX 26b (Std A) 
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Mailer Contact Information -  PRINTS IN BOX 5 and 6 (Std A)  

 

Use Employee from Statement - When this box is checked, the default Mailer 

Contact information will not be used.  We will use the Employee value that is entered on the 

postage statement. 

   

Default Carrier Information - PRINTS IN BOX 16a and 16b (Std A) if Carrier Makes Drop Ship 

Appointments box is checked.   

   

Default Comments - PRINTS in Comments Section of 8125 - if you cannot access default 

comments here, go to the 8125 Printing set up and select Pint 8125 Comments as entered.      

 

 
8125 Print Settings    

 
 
Do Not Print 8125 Ship Add - Check this box if you do not want the address of the 

BMC/SCF/DDU facility to print on the 8125.  

 

Do Not Print Gross Weight - Check this off if you do NOT want DAT-MAIL to print a gross 

weight figure on the 8125 form.  

 
Do Not Print Container Count - Check this off it you do NOT want DAT-MAIL to print container 

counts on the 8125.   

 

Print 8125 Comments - The 8125 contains several comment lines which can be automatically 

filled out. The way this is done is controlled by your selection.   

 

As Entered - All comment information must be added by editing the 8125.   If you want a 

constant comment to print on every 8125 that you generate, you can select this option and then 

enter the Default Comments on the right side of this screen. 
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Add Jobs - When this option is checked, the Job numbers from the statements that are 

associated with your 8125 will be listed in the comments section.  

 

Statement Comments - we will use the comments you entered from the Statement that 

generated the 8125.  

 

List Pallet Numbers - This option will print individual or a range of pallet numbers pulled from 

the Container information on the Mail.dat file used.    

 

Pallet Barcode Numbers - This option will print the Unique Pallet Barcode number assigned 

from the Mail.dat file.   

 

8125 Printer Button - Access to set a unique default printer for 8125s.  

 

8125 Copies - default number of copies printed 
 

Disable Printing of Tray/Sack Counts - When checked, we will not display the number of 

trays/sacks that are included on a Pallet. 

 

Print USPS Postage Statement ID - If you are using our Window Book Automation Scheduler 

to run the USPS MDR Client in batch mode for uploading your eDocs to PostalOne!, we can 

retrieve the USPS Postage Statement ID through the XML Receipts that are returned to us and 

have it print on your related postage statement.  
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8017 Settings 

 

 
 
Allow Creation of 8017 - Toggle checkmark on and off as desired. This controls whether or not 

you want our system to automatically create a corresponding 8125 when you have manually 

entered a drop ship postage statement.  

 

Always Create 8017 - Toggle checkmark on and off as desired. This controls whether or not you 

want our system to automatically create a corresponding 8017 form when you have manually 

entered an Origin destination entry postage statement.  

 

Do Not Print Gross Weight - Check this box if you do NOT want DAT-MAIL to print a gross 

weight figure on the 8017 form.  

 

Do Not Print Tray/Sack Counts - Check this box if you do not want us to print the number of 

trays/sacks that are included on a Pallet. 

 

Print 8017 Comments - The 8125 contains several comment lines which can be automatically 

filled out. The way this is done is controlled by your selection.   

 

As Entered - All comment information must be added by editing the 8017.   If you want a 

constant comment to print on every 8017 that you generate, you can select this option and then 

enter the Default Comments on the right side of this screen. 

 

Add Jobs - When this option is checked, the Job numbers from the statements that are 

associated with your 8017 will be listed in the comments section.  
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Statement Comments - we will use the comments you entered from the Statement that 

generated the 8017.  

 

List Pallet Numbers - This option will print individual or a range of pallet numbers pulled from 

the Container information on the Mail.dat file used.    

 

Pallet Barcode Numbers - This option will print the Unique Pallet Barcode number assigned 

from the Mail.dat file. 

 

DMU Destination Office - Enter your local DMU Post Office information so it will print on the 

8017 form. 

 

8017 Printer Button - Access to set a unique default printer for 8125s.  

 

8017 Copies - default number of copies printed 

 
 

User Defaults  
 

 
 

DAT-MAIL Statements has six user-defined fields which you can name yourself. Data entered in 

these fields can be included in reports created with a third party Report Writer or the optional 

report writer that is available for DAT-MAIL Staements. 

 

In the "User Default" screen, you can name the fields and create a "Hot Key" by placing an 

ampersand (&) in front of the letter you wish to make "hot". Please avoid using the letters O, H 

and C since they are already assigned to the OK, Help and Cancel buttons. You do not have to 

either assign hot keys or use the first letter of a title.    
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PostalOne!  
 

 
 
Note: The PostalOne! option requires a DAT-MAIL Registration that includes PostalOne!. This 

gives you access to your PostalOne! Login and Permit Info. 
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Entering Clients and Permits 

Clients and Permits can be added to DAT-MAIL manually.  If you need to associate a particular 

client with a particular permit this can also be accomplished in the system - the process is as 

follows: 

 

Adding a Client 
 

1. Open the "Client" list from the File menu in DAT-MAIL and type in the information for the new 

Client: 
 

 
 
 

From this screen click the Insert Button and begin entering the Company and Contact 

information by filling out all the relevant fields.  (Required fields are marked with an asterisk): 
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If you have an existing permit (see below "Adding a Permit") that you want to be associated with 

the client, you can add that information by clicking the "Permit" drop-down menu and choosing 

the appropriate permit number. 
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Once you have finished entering the client information press OK to save it, then repeat the 

process for the next client. 

 

Note: In order for the record to be saved, all required fields must be filled out. 
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Adding a Permit 
 
1.  Open the "Permit" file from the File menu in DAT-MAIL and type in the information for the new 

Permit: 
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On this screen click the Insert button to add a Permit record: 

 

 
 
 

At this point you can enter your permit information including the Permit number, City, State, Zip 

Code (required) and other pertinent information.   If the permit is a House Permit (used for all 

mailings) check the "House Permit" box, then add any other information you want to record about 

the permit such as phone number, expiration date, etc. as appropriate. 
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If the permit is associated with a particular Client, click the Client info button, which allows you 

to choose an existing client record from the Client Listing.  The Permit will then become 

associated with that client as their default permit. 
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Once the Permit information has been entered press OK to save the information, then repeat the 

process for the next permit.  The new Permit will appear as follows in the Permit Browse menu: 
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Setting up the Import Daemon 

General Setup 

Import Daemon  

 
The Daemon is a means of automatically importing your Mail.dat files from a hot folder of your 

choice.  You can choose different program setup options for the Daemon import behavior or you 

can choose to Sync Settings with the manual/single file import options.   

 

To access the Daemon setup menus start from the DAT-MAIL "File" Menu and choose the Program 

Settings => Program Setup menu, then click the "Daemon" Tab under "Import Defaults": 
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There are a few separate settings that are specifically for the Daemon: 

 

Run Entry Point - Entry and Local Postage CSV Export - Select a directory where this CSV 

Export Report will automatically be exported to. 

 

Import SEL Files - This option is for automatically importing spoilage files from intelligent 

inserters. 

 

Delay for Daemon - Set a time delay default for automatic import with the Daemon.   
 

By default, this option should be set to zero, but for those customers who get the "please 

insert next disk" error when transferring zip files to the Daemon's inbox directory, the delay 

should be increased to 5 or 10 minutes. 

 

Daemon Skip Segments for Invalid Mail - Use the checkbox to enable this feature in order to 

set the number of segments to import. All other segments will be ignored. This can be a helpful 

feature if your files always have the same number segments. For example, if you always mail two 

out of three segments, you would set this to "2" and the third segment would be ignored. The 

third segment could always be produced by your presort program for undeliverable or foreign 
mail pieces. 
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Import Files - settings 

Import Defaults Tab - Program Setup 
This is the program setup for Importing Mail.dat files, found under File => Program Settings 

=> Program Setup from the DAT-MAIL main menu.  Click on the "Import Defaults" tab.   

 

 
 

 
What these options are for: 

 

Default Import Directory - Press the Default Import Directory button and then select 

the path where you will be keeping your Mail.dat files. After selecting the path, it is displayed 
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next to the button.  Note that Mail.dat files can be imported from any directory, this is simply an 

option to go directly to the most commonly used path. 

 

Fast Network Option - If you are using DAT-MAIL on a network and your default import 

directory (where new Mail.dat files are placed) is also on a network, you should check this option. 

When it is checked, the Mail.dat files you have chosen to import are AUTOMATICALLY copied to 

the temp directory of your local hard drive, then our indexed work file is created during the 

import process. When the import is done, the work file is copied back to the network and listed in 

DAT-MAIL's Mail.dat file list so anyone on the network can access it. By performing the disk-

intensive import process on your local drive the import will be faster and will not slow down your 

network.   No temp files will be stored on your local computer.  

 

Do Not Import Piece Detail File - You can choose to not import the PDR file.  This will save you 

time during the import process and will not diminish the value of the data if you are not 

manifesting or tracking spoilage/shortage for 100% mailings. 

 

Park Piece Detail File - In addition to 'Do Not Import Piece Detail File' there is an option to 

'Park' that file.  When the file is Parked, it is retrieved when you perform a PostalOne! release 

upload. 

 

Do Not Import Piece Barcode File - You can choose to not import the PBC for much the same 

reason as stated with PDR.  This file can be large and by not importing it, you can reduce the time 

it takes for the import. 

 

Park Piece Barcode File - In addition to 'Do Not Import Piece Barcode File' there is an option to 

'Park' that file.  When the file is Parked, it is retrieved when you perform a PostalOne! release 

upload. 
 

Allow Changes to Data During Import - Checking this box allows DAT-MAIL to make 

corrections to Mail.dat files as they are imported, which means you can correct some common 

errors and make the Mail.dat file usable for production.  If you are using DAT-MAIL specifically to 

test and troubleshoot Mail.dat files, un-checking this box will give you a complete report of all 

errors found without making any automatic repairs. Unless you are specifically troubleshooting 

files, we recommend that this option remains turned on.  

 

Set In-Home Date to Zero - Your single file imports will automatically be stripped of the In-

Home date that was preset in the Container Summary file (CSM) so that you may set this date at 

a later time.  We suggest using our Mail Schedule View to set your mailing, shipping and in-home 

dates. 

 

Set Ship Date to Zero - Your single file imports will automatically be stripped of the Mail Date 

that was preset in the Container Summary file (CSM) so that you may set this date at a later 

time.  We suggest using our Mail Schedule View to set your mailing, shipping and in-home dates. 

 

Delete Mother Pallets - This option will strip Mother Pallets that were created from the presort 

so you may perform your own Palletization in DAT-MAIL.  Once you select this option, you can 

choose to delete which Mother Pallet levels you would like removed. 
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Run Batch Reports After Import - Another great automation feature giving you access to 

batch reporting right after Mail.dat import.   Review the Batch Report information in the section 

called DAT-MAIL Reports under Reporting and Accounting.   Set up your Batch Report profile then 

activate this feature.   

 

Recalc Container Weights After Import - This is a handy option if you find that you are 

getting inaccurate tare weights from your presort which are skewing report information.  There is 

an option at our Container Summary File View to run this process should you choose not to make 

this a default import option. 

  

Run Freight Table After Import - Our Toolbox clients have the option to automatically run a 

freight plan using a predetermined freight table upon import. 

 

Run PMOD Export - This option will automatically export container information from your 

imported Mail.dat file that will be mailed via Open and Distribute. 

 

Auto Export P1 Original File After Import - When chosen, we will automatically create a 

PostalOne! release file immediately after the import is completed that you can submit to 

PostalOne! as your Original file submission.  You will need to specify the export directory at our 

PostalOne! tab. 

 

Create Sibling Records on Import - If we find container types marked as Logical, we will 

automatically create physical siblings for each of those Logical containers.  You can specify which 

default sibling container type should be used at our Advanced Settings tab. 

 

Mark CSM's Included in Other Docs - When chosen, we will update your Container records 

with a value of I (copalletization is done at the Originator's site) or O (copalletization is done at 

another site).  Choose I or O at the PostalOne! tab. 

 

Conformance Testing: Conformance Testing examines and analyzes your Mail.dat files in great 

depth to look for errors upon import - without a performance penalty. Also present is a new error 

log format that is much easier to read and print. Use this valuable data to pinpoint and ultimately 

correct errors in your Mail.dat files. 

 

We offer conformance testing at five levels:  

 

Level 1: Referential Integrity testing only: no field level validation 

Level 2: Field Checking: Required fields, proper data types in populated fields and referential 

integrity testing 

Level 3: IDEAlliance Conformance testing:   Adds checks for valid values in populated fields 

according to the specifications outlined by IDEAlliance. 

Level 4: PostalOne!:  Adds checks to the fields required by PostalOne! This is not recommended 

for files you receive. Rather, this option is available for when you have imported a file and 

modified it to your needs. You can then export the file and re-import it using this validation level, 

so that you can determine if it will pass PostalOne! scrutiny. 

Level 5: Special Circumstances: For future applications. 

 

Mark Container Status - This setting is defaulted to "No Change" but you have the option to 

change this to "Preliminary" or "Blank".  "Preliminary" is useful if you are required by PostalOne! 

to provide them with files that will create Preliminary postage statements when the file is 

uploaded.  "Blank" is useful if your presort program consistently marks your Containers Statuses 

as "Ready To Pay" and you would prefer to have it blank.  
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Automated Statement Generation 

If you tend to import jobs that mail intact without much modification, you can create statements 

automatically during the initial file import.  Be sure to check the box "Generate Statements 
Automatically at Import" then click the Statement Setup button when it appears.  

 
 
Several pieces of data are required on statements that may not be populated or available in the 

Mail.dat file you are importing. Information like Client, Permit, the correct Job number and 

Description may or may not be present.  

 

When doing Automatic statement generation, DAT-MAIL first checks if the Job has been 

previously set up in the Job File and whether this information is present.  

 



45 

 

If the necessary Job information is present, DAT-MAIL uses the Client, Permit and Job data to 

create the statements. If the data is not present it will check ‘ statement information that may 

have been set up prior to import in some cases - including importing a single file at a time, doing 

a master import of a list of individual files, or running the Import Daemon.   
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Print Statements Automatically - check this box to have your statements print directly after 

they are generated.  Leaving this box unchecked simply means that you will print them later from 

the list in the DAT-MAIL Statements screen.  Click on the "3602" icon from any screen in DAT-

MAIL to open Statements for DAT-MAIL and access all your postage statements. 

 

 

 
Printer Name - set your default printer for automatic printing and set the number of copies.   

Print Breakout Report - will print a breakout report along with the statement if the statement 

contains multiple jobs.    

 

Print 8125 - will print the 8125 form if you are generating drop ship statement(s).    

 

Print 3152-A - will print the barcoded 3152-A form if you have an origin mailing and are 

participating in the USPS' Confirm ASN or Entry Info program and you have purchased this 

optional module for DAT-MAIL.  

  

Create PDF version of Statement - check this box to create a PDF in addition to your printed 

statements and other forms. 

  

Print only PDF - check this box if you only want a PDF of the statement and other forms. 

  

PDF File Defaults - you must set your directories here to tell us where and how to save your 

PDF files.  
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PDF Statement Root Folder - press the Select Folder button to select a folder for your PDF's.  

The screen that will be displayed will allow you to not only select a folder but also create a new 
one.      

Subfolder Naming - You must choose one data element for a subfolder name that will appear 

under the root folder.  If you are not assigning mail owners to your client records, you can select 

"Mail Owner Code" if you want all files in the same folder.  In that case, all files will appear in a 

subfolder under the PDF Root Folder called BlankOwner. If you wish to put the PDF's into folders 

that will accommodate your purpose, you can do so. You can create folders or a folder hierarchy 

using elements that include Mail Owner, Client Code and Job Numbers.   

 

As you define your subfolder, you can see your definition displayed on the Subfolder line below 

the buttons used to make your selection.  Use the Clear button to wipe out your selections and 

start over or the Erase Last button to remove your last entry. 

Subfolder name elements: 

You can choose up to three naming elements for your subfolders or create a subfolder hierarchy 

with these three elements:  Mail Owner, Client and Job Number.  If you want to include two or 

more of these elements in a single folder name, you should (but do not have to) separate these 

elements with a dash (-), underscore (_) or tilde (~).   

 

To create a subfolder hierarchy, press the \ subfolder button in between data 

elements. MailOwner Code creates a subfolder for each mail owner.  A mail owner code can be 

associated with one or more clients.  Press the Mail Owner button to set. You will see [OWNER] 
appear in the SubFolder line below the buttons. 
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Client Code - a subfolder is created for each client if you press the Client Code button.  If you 

also pressed the MailOwner button, a subfolder will be created for each MailOwner and below 

each MailOwner folder, a subfolder will be created for each client. You will see [CLIENT] appear on 
the Subfolder line.  

Job - the job number associated with the statement. 

File Naming Options: 

You can also use the Mail Owner, Client Code, Job Number or Lot as data elements in the PDF file 

name. We do not recommend using the same data element in both the sub-folder name and the 

file name though you can do so if you wish.  At a minimum, you must select 'Report Name' as 
part of the file name.  The report name consists of the following data elements:  

 Statement Form or supporting document name printed:  (such as 3602-R including dash, 

ConfirmASN for the form 3152-A, Breakout for a multi version breakout report, etc.) 

 Dash 

 Statement Control No (8 digits, zero padded) either the consolidated statement control 

number or the statement control number.  If the form is an 8125, the 8125 control 

number is used. 

 Dash 

 Date and Time Stamp of when it was created (MMDDYYYYHHMMSS format). 

If you plan to create a folder for each client, you should include the job name as part of the file 

name, probably putting it first so that the client can easily see which statements are associated 

with each job.      
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Options Tab 

 

  
Spoilage Adjustment Percent - removes pieces from the statements to reflect estimated 

spoilage across all rate categories.  

  

Calculate Spoilage On Lowest Rates - removes the indicated amount of spoilage from the 

lowest rates in the mailing statement. 

  

Options Checkboxes - toggle to turn on or off        

 

Generate 8125 - Choose an 8125 radio button option in order to have the system automatically 

create an 8125 for your destination entry point postage statements.       
     

Optional Procedure - If you participate in the USPS Optional Procedure program, check this box 

and you will be able to run our Optional Procedure report from the Reports menu of Statements 

for DAT-MAIL.        

 

Check Request - Check this box if you would like the postage amount added to your Check 

Request report for your Accounting department.   

 

Drop Ship - Creates consolidated statements in addition to individual statements.       
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Update Container Group ID to Zip-Ref - Check this box if you'd like this ID to print in the Zip 

Reference box of the postage statement.        

 

Applied Method/Balance Paid By - If your Mail.dat file has postage affixed, this section of the 

screen will become accessible and you must enter the amount applied and how the balance of 

funds will be paid if postage is not affixed at the correct rates. This button will appear if you have 

purchased the optional module for Confirm ASN/Entry Information.  Inside, you can check a box 

"Planet Code All Pieces" and then enter the Planet Code number.  The planet code can also be 

entered at the Segment View.    

  

Prepared By - Choose from your employee list or add new.  Their name and initials will appear 

on the postage statement if you have selected this option in Program Setup of Statements for 

DAT-MAIL (under the File menu). 

  

Carrier - Choose from your carrier list or add new.  Their name will print on the 8125 form in box 

12a if you have selected this option in "Program Setup" of Statements for DAT-MAIL (under the 

File menu).        
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Statement Comments and more Tab 

 

Comments 1, 2 and 3:  Enter applicable statement comments if needed.    

You can also access six User-defined fields for customizable data entry. 

  

Once all info has been entered/adjusted on the tabs, press the Generate Statements button to 

return to the "Importing New File" screen and then hit OK to begin the Import process. 

   

 

If you have not chosen to Print Statements Automatically, you can click on the "3602" Icon in the 

upper right hand section of this screen or any other screen in DAT-MAIL to enter Statements for 

DAT-MAIL at any time.   
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This screen will appear: 

 

Click on the Statements menu to see the menu of statement lists to choose from: 

First Class/Standard Mail 3600/3602 - A complete list of every First Class or Standard (A) 

postage statement you have generated.  

Periodicals Statements 3541 - A complete list of every Periodical postage statement you have 

generated.      

 

USPS Consolidated Statements - A complete list of the Consolidated Drop Ship postage 

statements you have generated.  You also have access to printing and editing options of the 

corresponding 8125 form for each of the entry points on your Consolidated postage statement.      

 

Note: The Consolidated postage statement is made up of all of the individual entry points of one 

mailing.  You can choose to print the Consolidated form from this menu OR print the individual 

statement from the First Class / Standard Mail, Periodicals Statements or 3605 Parcel Services 

and Priority menu lists depending upon the class of mail.      

 

3605 Parcel Services and Priority - A complete list of 3605 and 3600 postage statements 
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DAT-MAIL Manual Functions 

 

How to Import a Mail.dat File 

From the main menu press the second icon from the left, . If you point to the icon with your 

mouse pointer, a tip box will say "Import New Mail.dat file".  You can also go to the "File" Menu 

and select "New Mail.dat Import" from the menu. 

 

 

 
Press the Select Mail.dat File button and select the Mail.dat file you wish to import. It can have 

either a "ZIP" or "HDR" extension. If it is a zipped file, after you select the file, it will be 
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automatically unzipped and you will see the "HDR" extension appear in the File Select dialog. 

 

The Job ID and Description will automatically appear on the screen. You may overwrite them with 

different information. 

 

If no estimated mail date, in-home delivery date or delivery window is present in the file, you 

may assign this information during import. If another Mail.dat program has already populated 

these fields, the original information will be used. 

 

If there are no estimated mailing dates, in-home delivery dates or delivery windows present, you 

may assign them. The delivery window will default to "3" when a Mail.dat file is selected. 

 

Conformance Testing - the level of validation for this particular import can be selected here, 

ranging from "No Validation" to "PostalOne Testing". Testing level will default to your setup values 

but can be edited prior to import. 

 

The "Do not Import Piece Detail File", "Do Not Import Package Quantity File" checkboxes will 

default to your setup values in the Program Setup tabs, but you can override them for this 

specific import on this screen. 

 

If you check "Generate Statements Automatically at Import", a button will come up giving you 

access to enter your Statement Information. 

 

Press OK to begin the import. The time it takes to import will vary with the density of the mailing, 

its entry plan and whether you are reading the data from a network or local drive. You can 

transfer these imported files to other users in the DAT-MAIL "TPS" format to eliminate the need to 

import the same files elsewhere. You can also share imported data over the network. There is no 

limit to how many users can view the same Mail.dat file. These functions can replace hard copy 

reports on the production floor if you have workstations in the proper locations.  

 

 
 

Automatic Unzip Troubleshooting    
 

Importing a file whose unzipped file name is already present in your default Mail.dat directory. 
 
We know the file name inside the zip file by saving a list of all the "HDR" files in the directory before the 
unzipping is done and then checking this list after the unzipping is completed. The 'new' file is the 
one automatically selected so if there is no new file, the program doesn't know which file to select.  
 

 
There is more than one set of Mail.dat files in the zip file.  
 
The program will only select the first new file.  
 

 
The default Mail.dat path selected in the Program Setup is invalid.  

 
The program will unzip the files to that path (unless fast network import is enabled) so if it is invalid, the 
unzip will not work. 
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Editing the MPA File 

 
In order to make changes to the MPA file you can open the file in the Navigator (Mailer Postage 

Acct file view): 

 

(Note: The Navigator should appear automatically when you choose your mail.dat file from the 

DAT-MAIL main menu)  
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Click the "Mailer Postage Account File" menu item which brings you to this screen: 
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From here you can make changes to the file as necessary by clicking the Change button: 

 
 

 
 
 

From this screen can add (or edit) a Description, or change any information such as Permit 

Number, MID or CRID, Mailing Facility DUNS number, as appropriate... 
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Generating the Postal One! Release 

 

How to generate the PostalOne! release from DAT-MAIL 

 
 
 

Step 1 - From the Navigator screen click the Statement Generate button: 

 

 
 
 

Step 2 - Check the box next to the entry point fro which statements are to be created and click 

"Generate Statements" on the top tool bar.  When Statement Generate is complete you will 

receive a "Successful Generation" message.  
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Step 3 - Click on the PostalOne! button on the top toolbar 
 

 
 
 

Step 4 - Click the Create a Release button to create your PostalOne! release for upload to the 

USPS: 
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Step 5 - The release is now ready for upload to the Production environment (or TEM for testing). 
 

 
 
 

The next sequence (uploading the PostalOne! release to the dashboard) is shown in the 

“Uploading to PostalOne! Release” section of this manual... 
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Postal One! Functions 

 

Uploading the DAT-MAIL PostalOne! Release 

After you have made the PostalOne! release in DAT-MAIL it can then 

be uploaded to PostalOne! for processing.  Once uploaded, validated by PostalOne! and accepted, 

the job will appear on the Business Customer Gateway Dashboard.  

 

The process for doing this is outlined below.  

 
 

Step 1 - Log in using your PostalOne! username and password: 
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Step 2 - Select the "Job Validation/Upload' red menu option:  
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Step 3 - Click on the "Add Jobs" link as shown here: 
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Step 4 - Highlight the Job to be added (in this example "TEST1985.zip") and click 'Open' 
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Step 5 - Check the "Upload after Validation" radio button, then click "Validate and Upload"  
 
 

 

 
 
 

 

  



69 

 

Step 6 - After being chosen the job is validated by PostalOne!.  PostalOne! Validation includes 

things like checking and confirming MIDS and CRIDS and validating the permit numbers used in 

the Job.  Click the "Accept Agreement" button. 
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A box will appear on the screen, showing the progress of the upload: 
 
 

 
 

 
 

After the Job has been uploaded and validated it will appear in the Dashboard - to get there Click 

"view Validation History" and check for a 'Complete' message in the Submission Status column on 

the far right.   

 

The Job is now complete and will appear on the Business Customer Gateway dashboard 

along with other jobs from your company that have been processed or are being processed (see 

example below).   
 
 



71 
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If validation fails: 
 
If for any reason the validation fails you will see something like the following on the Dashboard - 

a "Validation Failed" message will be received.   

Click „View Validation Upload History‟ and see „Client Validation Failed‟ in the Submission Status 

Column: 

 
 

 
Click on the Job-ID to display the validation error 
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Correct the validation error in DAT-MAIL and resubmit the job for validation until the 
„Complete‟ message is received.  
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"Original Release" vs. "Updated Release" 

For each Mail.dat file there is the initial "original" release and a second "updated" release 

generated by the DAT-MAIL software.  These are both uploaded to the PostalOne! interface.   

 

The original release is the original Mail.dat file with modifications from the DAT-MAIL software, 

and the "updated" release (also known as the "ready to pay" version of the file) should accurately 

represent the contents of the actual physical mailing that is being sent to the US Postal Service. 
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PostalOne! Help Desk Contact Info 

Postal Once Customer Care: 
 
https://www.usps.com/postalone/contact.htm 
 
 
Screen shot (as of 11/18/2013): 
 

 

 
 

https://www.usps.com/postalone/contact.htm
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Updating the USPS MDR Client Software 

How to Install and Configure the PostalOne!® Mail.dat Client Software 

The PostalOne!® Mail.dat Client software must be loaded onto the same computer where you will 

be running our MD Service Manager software, because Windows operating systems such as Vista, 

Win7, and Server 2008 do not allow a service to launch an application that is on a network share.   

Do not load the USPS software into Program Files, because the USPS programs will update the 

Debug.log (and others) in its own folder.  Some security models require administrator 
permissions to update files in Program Files. 

There are three separate PostalOne! sites for uploading your Mail.dat files and each site has a 

specific  PostalOne!® Mail.dat Client software package – one for PROD (production), Test 

Environment for Mailers (TEM) and Customer Acceptance Testing (CAT).   

Mail.dat Service Manager can be configured to monitor any one, two or all of three of those sites 
when you are working with PostalOne!. 

Download the USPS MDR Client software by logging into the Business Customer Gateway 

https://gateway.usps.com/bcg/login.htm and clicking on the Electronic Data Exchange link.  You 

will then be directed to the Production or Test Environment for Mailers (TEM) area to download 

the respective software. 

https://gateway.usps.com/bcg/login.htm
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Each PostalOne!® Mail.dat Client software package gets extracted into its own directory and each 

of those have their own Login and Settings information.  After downloading the PostalOne!® 

Mail.dat Client software, make a folder and unzip the contents.  A good example for naming your 

directory would be C:\USPS TEM\<install date> or C:\USPS PROD\<install date> or C:\USPS 
CAT\<install date>.   

Inside that folder you‟ll want to launch the run-mdclient.bat batch file and instead of logging in, 

go to the top/right of the screen and click on the Settings button to fill in the Batch Mode 

information.  Follow the instructions below to set the necessary information we require in order to 
monitor your Mail.dat file statuses.  Then click OK: 
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On the General tab, select a “Log” folder and set your “Time Zone”.  Highly suggest that the Log 
folder be created as such: C:\USPS TEM\Logs. 

 

On the Batch Configuration tab, enter the following information: 

 Your PostalOne!® username and password 

 Set upload run time (30) and sleep time (3) 
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 Define the Batch File locations.  We strongly suggest creating these directories at the root 
of C:\USPS TEM used in this example: 

 

On the "Receipt Files" tab, enter the following information: 

 Receipts Repository – folder where PostalOne!® Mail.dat Client Software saves receipts to. 

 We strongly suggest creating this directory at the root of C:\USPS TEM\Jobs as shown in 

this example 

 Receipt Format – choose Enhanced XML 

 Postage Statement Filter – choose Billable 
 Receipt File Name – use the following value: status_receipt_{0}_{1}.{5} 

The {0} will be replaced by JobID, {1} will be replaced by date and time, and {5} will be 

replaced with TXT or XML. It is important to allow PostalOne!® Mail.dat Client Software to 

name the status receipts this way because “Receipts will stop downloading if a file with the 
same name already exists in that download folder” - (USPS technical spec). 

 Set the receipt poll run time (30) and sleep time (5)  
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Turn Off Security Warnings on USPS MDR Batch Files 

Some environments will warn you about running batch files and demand your input.  Since the 

USPS MDR Client processes are started with batch files, it is important to log into the computer 

with the account that the Scheduler will be running under, then manually starting the two batch 
files.   

Double click on runBatchUpload.bat.  If you get a Security Warning box, be sure to uncheck 

the “Always ask before opening this file” and then click Run.  After it starts, close the CMD.exe 

process it started.  Repeat the above step for runReceiptPoller.bat.  If you do not disable these 

Security Warnings, it is likely that when executed as a service they will fail to start.  Repeat this 
step for each folder where USPS MDR Client software is installed (PROD, TEM, CAT).   

If you launch either one of the .bat files and notice that the DOS window automatically appears 

then the Security Warning will not be an issue. 
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Stopping MD Service Manager and USPS MDR Client Sessions 

There are times you may want to shut down MD Service Manager and the USPS MDR Client 
software (such as when the USPS MDR Client needs to be updated).    

MD Service Manager runs as a service and, as such, the two USPS MDR Client processes are 

called from the service (there are two for each site being monitored – one for Mail.dat upload, 
and another for status receipt polling).    

Services do not have a user interface and their processes do not display windows.  You will not 

see the command processor (DOS window) running the USPS MDR Client software.  This can pose 
challenges when you want to shut down the USPS MDR Client. 

In order to stop MDSM, you will first need to either stop the WBI Automation Scheduler, or stop 
the MD Service Manager Plug-in.   

 To stop the Window Book Scheduler, open the Control Center and press the Stop Service 
button. 

 To stop the MD Service Manager Plug-in, highlight the service in the Window Book 

Scheduler Control Center and click the Edit button.  Select „End Date‟ and choose 
yesterday‟s date then click OK.   

In order to stop the USPS MDR Client processes is to go to Task Manager and look for cmd.exe 

processes for all users.  You can then End Process to close the runReceiptPoller.bat and 

runBatchUpload.bat sessions.  If the Task Manager version can display the “Command Line” 

column (View menu, Select Columns) then you can look at the path to confirm that the process 
being stopped is the intended one. 
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Updating the USPS MDR Client: 

Follow the previous step outlined in Stopping MD Service Manager and USPS MDR Client 
Sessions. 

We do not recommend installing (or unzipping) a new USPS MDR Client over an existing 

installation.  We have seen numerous times where the configuration data is wiped out which halts 

the monitoring process.  The USPS also does not recommend installing over existing files. 

The preferred recommendation is to: 

Make a new folder each time there is new USPS MDR Client update and unzip the files there.  If 

you followed our initial installation suggestion that your directory names would be patterned as 
such: 

C:\USPS TEM or C:\USPS PROD or C:\USPS CAT, then your new directory name for a USPS MDR 
Client update might look this… 

C:\USPS TEM\<old install date> 
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C:\USPS TEM\<new install date> 

Or 

C:\USPS PROD\<old install date> 

C:\USPS PROD\<new install date> 

Or 

C:\USPS CAT\<old install date> 

C:\USPS CAT\<new install date> 

Reconfigure the new version of the USPS MDR Client software by following the steps outlined in 

Configuring your PostalOne!® Mail.dat Client Software.  The existing General, Batch and 
Receipt directories can be re-used. 

From the Window Book Scheduler Control Center, edit the MD Service Manager Plug-in for the 

expired USPS MDR Client by choosing „Disable‟.  Create a new Configuration for the updated USPS 

MDR Client. 
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MDR Client Software updates 

The USPS periodically makes updates in the PostalOne!® system to incorporate enhancements 

and bug fixes to the software. Major changes are performed when there are significant changes to 

postal rates or regulations (for instance when the USPS does a January price increase).  Usually 

there are at least four PostalOne!® software updates during the year: January, April, July, and 

October. There can also be interim updates to PostalOne!® for immediate fixes or other system 

issues.   

 

It is important to download and install the USPS Mail.dat Client software (also called MDR Client) 

as soon as it is available. This software can be downloaded from the Business Customer Gateway 

web site. You may also need to make any associated updates or configuration changes to 

software that interfaces with PostalOne! once the Mail.dat® Client software is updated. 

 

MDR client update notification is by e-mail from the USPS.  In order to receive notification of 

PostalOne! updates send an e-mail to dmmadvisory@usps.gov and ask to be added to the 

distribution list. You can also review previous DMM Advisory notices at 

http://pe.usps.com/dmmadvisory.asp.  The software will also warn you if the MDR Client on your 

desktop is out of date and prompt you to download and install the latest version. 
 

  

https://windowbook.infusionsoft.com/app/linkClick/34181/9bb186adf6757631/9267143/4fff2d3b281fbe62
mailto:dmmadvisory@usps.gov
http://pe.usps.com/dmmadvisory.asp
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Recording and Saving DAT-MAIL Settings 

Making Screen shots of your settings 

 

Making and saving screen shots: 

 

To create and save a screen shot press the <Alt> <Print-Scrn> buttons together on your 

keyboard.   Then paste the result (<Ctrl>-V) into a graphics file for instance a .jpg, .pgn or .bmp 

file.  You can use MS Paint to save screen shots into individual files.  You can paste more 

than one screen shot into an MS Word document (.doc or .docx) using the same procedure, if you 

want to save the information to a single document. 

 

Examples: 

 

From this menu: 

 

 
 
 



86 

 

Click "Program Setup" and Choose the "PostalOne!" tab.  You can then make a screen shot (see 

instructions above) and paste it into a graphics file (or a Microsoft Word Document).    

 

Screen shot of PostalOne! settings (Program Setup screen): 
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Likewise for other Tabs on the 'Setup' screen, for instance the "Import Defaults" tab: 

 

 
 
 
You can make and save screenshots of your Setup screens (or any other screens) in this way to 

keep the settings for future reference.  For instance it could possibly be necessary at some point 

to re-install and re-configure the DAT-MAIL program after a computer hard drive failure. 
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How to Document Installation Settings 

PURPOSE 

 
The 'EII_Client_Information' file was created in order to have as a reference, a Client's system 

settings in the form of screen shots as they appeared at the time of installation.  This becomes a 

valuable reference tool should a re-installation or re-configuration of DAT-MAIL be required due to 

an event such as a hard drive failure.  The file contains Client-specific worksheets that also house 

pertinent installation details like original installation date, name of the installer, installation type 

(single or multiple), file path information, etc.  Each Client-specific worksheet is created by the 

person performing the install for the Client and is based on a worksheet Template that is also 

included in the file.   

 
 

LOCATION AND ACCESSIBILITY 

The 'EII_Client_Information file was created in MS Excel and then imported into Google Docs for 

ease of use by both Window Book and EII employees.  To gain access to the file, it must be 

shared by the file's owner using a GMail address.  To obtain a GMail address if you don't already 

have one, click the following link: 

 

https://accounts.google.com/SignUp?service=mail&continue=http%3A%2F%2Fmail.google.com

%2Fmail%2F%3Fpc%3Dtopnav-about-en 

 

To request access to the file, contact Window Book's Laura Burish at lburish@windowbook.com.  

Make sure to include your GMail address with your request! 

 

When the file has been shared with you, an invitation email will be automatically sent to your 

GMail Inbox along with a link to the file.   

 
 

CREATING A NEW CLIENT WORKSHEET 
 
A worksheet does not display in it's entirety in the viewing area of the screen; therefore 

up>down, and left>right scroll bars are available for navigating the worksheet.    

 

To create a new Client worksheet, perform the following: 

1. With the 'EII_Client_Information' file open, select the 'TEMPLATE' worksheet from the 
horizontal list of names found at the bottom of the file; 

https://accounts.google.com/SignUp?service=mail&continue=http%3A%2F%2Fmail.google.com%2Fmail%2F%3Fpc%3Dtopnav-about-en
https://accounts.google.com/SignUp?service=mail&continue=http%3A%2F%2Fmail.google.com%2Fmail%2F%3Fpc%3Dtopnav-about-en
https://accounts.google.com/SignUp?service=mail&continue=http%3A%2F%2Fmail.google.com%2Fmail%2F%3Fpc%3Dtopnav-about-en
mailto:lburish@windowbook.com?subject=EII%20Client%20Document%20Access%20Request
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2. Click on the down-arrow that appears next to the name of the worksheet (i.e. TEMPLATE) 

and select 'Duplicate'; 
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3. The worksheet 'Copy of TEMPLATE' will be created and displayed.  Click the down-arrow 

located to the right of the worksheet name (i.e. 'Copy of TEMPLATE') and select 

'Rename...'; 

 

 

4. Rename the worksheet using the Client's name and Client ID (e.g. Rocky Mtn (2011)).  If 

more than one installation has occurred for this Client (same Client, different location), 

include a reference to the location where the installation took place, such as the street 

name.  Press the Enter key on the computer key board after entering the name 
information for the newly created spreadsheet; 
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5. Client worksheets should be kept in alphabetical order; however, the TEMPLATE worksheet 

should always remain at the head of the list (far left) for ease of use.   

Single click, hold, and drag the newly created Client worksheet (i.e. 'Rocky Mtn (2011)') to 

its correct alphabetical position within the workbook; 
 

 

Once the Client worksheet has been created, renamed, and moved to its correct position in the 

file, the installer can begin to fill in the necessary installation detail. 

 

NOTE:  Google Docs automatically saves any changes to a file as they occur; therefore, you are 

unable to perform any type of manual save of it.  If you want to see what changes had been 

made since the last save or even prior to the last save, click the 'All changes saved in Drive' link 

located to the immediate right of the file's top-line menu. 
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COMPLETING A CLIENT WORKSHEET 
Once the Client worksheet has been created, the Installer can begin filling in the necessary fields.  

The Client worksheet should always be open on the Installer's PC, not the Client's PC/server.  The 

following are the list of fields found on the Client worksheet and descriptions or instructions for 
each: 

 Client Name / Client ID 

 Address 

 Phone 

 Subscriber Name 

 E-mail Address 

 Installed by Company: Enter an 'X' in the appropriate field to signify whether the install 

was done by Window Book or EII. 

 Installed By (Individual Name): Enter the first and last name. 

 Client Install Assistant: Enter the full name of the person located on-site for the Client 

that assisted the installer. 

 PSQL License Code 

 DATMAIL Registration Code 

 IDEAlliance ULC 

 Install Date: Enter the full date in any format.  Once the Enter key on the keyboard is 

pressed or if you tab out of the field, the field will automatically display the date in the 

following format: 'YYYY-Mmm-DD', e.g. Entering '2/9/14' will display as '2014-Feb-09' 

(there is a slight delay before the automatic format change takes place, so be patient). 

 Installation Type: Enter an 'X' in the appropriate field to signify whether the installation 

type is a single install or a network (multiple user) install.  Signifying a single install 

(installation occurred on either the C or D drive) will cause the various InstallAware path 

fields and DAT-MAIL Path Names to auto-populate.  Signifying a network install will require 

manual entry of the various InstallAware path fields and (see Step 10 for more information 
on entering the network install/multiple user DAT-MAIL Path Name fields) 

 

 

 DATMAIL Version Info & Installation: The required information for this field should be 

downloaded directly from the Client's DAT-MAIL software, saved to their PC/Server's 
Desktop and emailed by the Client, to the Installer.  To do so, perform the following:  
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1. Launch the Client's DAT-MAIL software after the installation has taken place.  From 
the top-line menu bar, click on 'Help' and then select 'About DAT-MAIL'; 

 

 

2. DAT-MAIL's About DAT-MAIL dialog will display.  Click the MORE About... button; 

 

 

3. The DAT-MAIL's More About... dialog will display.  Click the 'Environment' tab to 

display the 'Environment Information' and then click the Export button; 
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4. An Export dialog will display.  Make note of the export path where the environment 

information file will be saved to.  If you'd like to change the path to something like 

the Client's PC's Desktop (recommended), click the Browse icon to the right of the 

Export File Path field and select the specific location you'd like the file to be 
exported to.  Click the OK button; 

 

 

5. Once the export is complete, the Export Confirmation dialog will display.  Click the 

OK button; 

6. Have the Client or Subscriber email the 'DatMailAboutExport.txt' text file to the 

Installer; 
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7. Open the 'DatMailAboutExport.txt' file on the Installer's PC.  Highlight the first line 

of text (i.e. "DAT-MAIL Editor with Toolbox...") (see image).  With the line 

highlighted click the 'Edit' menu from the top-line menu bar and select the 'Copy' 

menu option (or using the PC's keyboard, while holding down the 'Ctrl' key, press 
the letter 'C'); 
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8. With the appropriate Client's worksheet displayed on the Installer's PC, place the 

cursor on the first, yellow highlighted field of the 'DATMAIL Version Info & 

Installation Folders' section; 

 

 

9. Using the PC's keyboard, hold down the 'Ctrl' key and simultaneously press the 'V' 

key to paste the copied information from the .txt file into the Client's worksheet.  

The copied information will display.  Confirm that it is the same information that is 
located in the .txt file; 
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10. This next step (Step 10) is only required if the installation is for multiple users 

(network installation).  If the install is a single instance type, proceed to Step 13.  

If the installation is for a single install, the data required for these Path Name fields 

(InstallAware and DAT-MAIL) will auto-populate in the Client worksheet when an 'X' 
is placed in the appropriate Single Install field: 

 

 

 

For multiple user or network installations, from the .txt file, highlight the required 

path name information to be copied into the Client's worksheet.  With the path 

names highlighted click the 'Edit' menu from the top-line menu bar and select the 

'Copy' menu option (or using the PC's keyboard, while holding down the 'Ctrl' key, 

press the letter 'C'); 
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11. Display the Client worksheet.  Place the cursor in the first or left-most field of the 

second highlighted line containing the text, "PATH NAMES (EXAMPLE TO BE...)"; 
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12. Using the PC's keyboard, hold down the 'Ctrl' key and simultaneously press the 'V' 

key to paste the copied information from the .txt file into the Client's worksheet. 

 The copied information will display.  Confirm that it is the same information that is 
located in the .txt file; 

 

 

Note:  The screen shots used above are for demonstration purposes only.  They 

depict an install directory of 'C:\', which would not be the case for a multiple user 
or network installation.    

13. And lastly, from the .txt file, highlight the SQL connection confirmation located at 

the bottom of the .txt file to be copied into the Client's worksheet.  With the SQL 

connection confirmation line highlighted, click the 'Edit' menu from the top-line 

menu bar and select the 'Copy' menu option (or using the PC's keyboard, while 
holding down the 'Ctrl' key, press the letter 'C'); 
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14. Display the Client worksheet.  Place the cursor in the first or left-most field of the 

last, highlighted line containing the text, "Copy SQL Connection Info HERE"; 
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15. Using the PC's keyboard, hold down the 'Ctrl' key and simultaneously press the 'V' 

key to paste the copied information from the .txt file into the Client's worksheet. 

 The copied information will display.  Confirm that it is the same information that is 
located in the .txt file. 

 

 
 

   

 Installation Notes:  Located to the right of the 'DATMAIL Version Info & Installation 

Folders' field, this is a free-text field that can be used by the installer to record any 

pertinent information about the install, client, environment, etc. If updates to the Client 

worksheet should occur after it has been created (i.e. the Client requires a re-installation 

and decides to change one of their installation settings, the Client worksheet should be 

updated accordingly, and the 'Installation Notes' field should be updated to include what 

changes were made, who made them, and when. 

The remaining portion of the Client worksheet involves the importing of DAT-MAIL's and 

PostalOne! system setup screen shots after the installation has taken place. 

 DAT-MAIL Configuration Screen Shots:  

o Imports Default Tab:  To display the tab, obtain a screen shot, and import that 
screen shot into the Client's worksheet, perform the following:  

 

1. Using GoToMeeting, launch the newly installed DAT-MAIL on the Client's 

PC/Server; 

2. From the top-line menu bar, select 'File', 'Program Settings', and 'Program 
Setup'; 
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3. DAT-MAIL's Setup dialog will display.  The Setup dialog is comprised of 

various tabs.  When the Setup dialog is launched, the default tab to display 

is the Import Defaults tab, which is the first screen shot required for the 
Client worksheet;   
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4. From the Installer's PC, launch the MS Snipping Tool by clicking 'Start' and 

then typing "Snipping" in the Search field. Select the Snipping Tool from the 

search results; 

 

 

5. Using the Snipping Tool from the Installer's PC, click and drag the cursor 

around the image of the Client's DAT-MAIL Setup screen (Import Defaults 
tab) viewable in GoToMeeting; 
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6. When you let go of the cursor, the Snipping Tool will display the image of 

what you highlighted.  Click the Save icon in the top left corner; 
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7. A Save As dialog will display.  Create a folder on the Installer's Desktop and 

name it something meaningful (e.g. "ClientScreenShots").  Click the Open 

button when finished;   

 

8. Name the image (e.g. "ImportDefaultsTab") and save the image as a .png 
file.  Click the Save button when finished; 

 



107 

 

9. Display the Client worksheet.  Place the cursor where you would like to 

import the ImpotDefaultsTab.png image - directly below the label "Import 

Defaults Tab"; 

 

 

10. From the top-line menu bar, select 'Insert' > 'Image'.   
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11. An Insert Image dialog will display.  Click the Choose image to upload 

button located in the center of the dialog;  

 

 

12. A Choose File to Upload dialog will display.  Locate the 'ClientScreenShots' 

folder created on the computer's Desktop and select the file located in that 
folder to import (i.e. 'ImportDefaultsTab.png').  Click the Open button; 
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13. The image (ImportDefaultsTab.png) will display in the Client worksheet in 

the area reserved for the screen shot of the Import Defaults Tab; 

 

 

14. Perform the same procedure for the remaining four DAT-MAIL configuration 

screen shots, saving all of the .png files in the same 'ClientScreenShots' 

folder located on the Installer's Desktop: 
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o Mailer Information Tab 

o Statement Generation Tab 

o Export/Archive Tab 
o Pallet Tracking/Intelligent Mail Tab 

 

o PostalOne! Release Path:  Perform the same procedure for importing the 

PostalOne! Release Path screen shot into the Client worksheet that was performed 

for the DAT-MAIL Configuration Screen Shots. 
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The creation and completion of the Client worksheet is complete!  Log out of Google Docs.  
 


